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1.0 INTRODUCTION 

1.1 General Information 

The StrataBox™ is a portable, low power, high-resolution, and water-resistant marine sediment imaging 
instrument capable of delivering 6 cm of marine sediment strata resolution with bottom penetration of up 
to 40 meters. It is designed exclusively for inshore and coastal geophysical marine survey up to 150 
meters of water depth and operates at 10 kHz.  Included with the StrataBox™ product is the following: 

 
• StrataBox™ Sensor Unit 
• StrataBox™ Transducer Assembly 
• StrataBox™ Installation CD 
• StrataBox™ Manual 

StrataBox™ Sensor Unit provides all of the transmit/receive electronics, and all of the signal processing 
functions.  It is powered from a 10-30VDC source and consumes 8 watts of power. It interfaces to the 
Host PC via a single COM port.  The mechanical case for the Electronics Unit is Water Resistant to the 
EN60529 IP65 Specification and is also UV Stable and Chemical Resistant.  

The StrataBox™ Transducer Assembly is a Line-in-Cone type transducer with an anodized aluminum 
ring attached.  The ring provides a means to affix the transducer to the appropriate mounting hardware.  
The transducer itself provides 300 Watts of Low Frequency energy for bottom penetration of up to 40 
meters (sediment dependent).  It is lightweight and well suited for portable applications. 

The StrataBox™ Installation CD will install the PC software used to configure, control, and acquire data 
from the Stratabox Sensor device.  It will also include this manual in PDF format and any Release Notes 
that have been generated. 

A hardcopy of the Stratabox™ Manual is also included so that the user may learn to install, operate, and 
maintain the Stratabox™ Equipment and Accessories.  The manual also includes a section on acoustic 
theory. 

The Stratabox PC software was designed for use with the Windows 98 operating system, but will operate 
under Windows 95/2000/ME also.  We recommend the software be used on a PC with a processor speed 
of at least 266 MHz.  The software requires at least 1 available Serial Port for connection to the Stratabox 
instrument, and optionally, an additional Serial Port for NMEA Navigation/GPS Input.  The software 
features Navigation Input, Data Storage, Zoom Modes, Thermal Printer output, Automatic/Manual 
Eventing, and more.  The Stratabox software interface is divided into two fields.  The Controls field is 
located on the left and contains navigation/depth information, configuration buttons, and system status.  
The Data field is located on the right and contains the actual acoustic echo data.    

1.2 About This Manual 

This manual contains important information regarding acoustic theory, installation, operation and 
maintenance of your new equipment.  The user should take sufficient time to read the entire manual and 
to understand the full functionality of the Stratabox Sensor and PC Software. 

The manual is organized into four chapters:  
 
1) An introduction (this section), which provides a system overview and basic outline of echosounding 

acoustics. 
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2) Installation, which provides details on how to properly mount all of the Stratabox System 

components.  Details on installing the Stratabox PC Software package are included also. 
3) Operational instructions describing how to operate the Stratabox Sensor unit and the Stratabox PC 

Software. 
4) Maintenance, which provides information on replaceable parts and troubleshooting guidelines.   
 
The user should pay attention to notes that are displayed in a gray box.  These notes contain important 
information regarding installation and use of the Stratabox System.  An example is given below: 
 
NOTE: Important operation and installation information is provided in gray boxes 

throughout the manual. 

1.3 Echo Sounding Principles 

Basic echo sounding principles that should be understood by all operators of hydrographic equipment are 
provided in this section.  

1.3.1 Underwater Acoustics 

1.3.1.1 Decibels 

The scale most often used to describe a measurement unit of sound is the decibel (abbreviated “dB”).  The 
decibel system was selected for a number of reasons.  First, it is a logarithmic system, which is useful for 
dealing with large changes in measured quantities.  Decibel units make multiplication and division simple 
because they are reduced to an addition and a subtraction operation respectively.  Secondly, for 
underwater acoustics, the primary concern is ratios of power levels and signal levels rather than absolute 
numeric values. 

Transducer calibration values are typically provided in units of decibels, including source level, receive 
sensitivity and directivity index.  These transducer calibration values are outlined later in this section.  
These quantities are used to predict performance levels of a given transducer used with a sonar system. 

1.3.1.2 Sound Propagation 

The sea, together with its boundaries, forms a remarkably complex medium for the propagation of sound.  
Figure 1-2 shows the interaction of a transmitted sound source and the water.  Both signal loss and 
interference result from interactions with boundaries and components within the water column, causing 
the source to be delayed, distorted and weakened.  The main components affecting sound propagation are 
spreading loss and attenuation loss. 

Spreading Loss 

As a transmitted pulse of sound leaves the transducer, it spreads out in all directions.  At the transmission 
point, the sonar puts a fixed amount of energy into the water.  As the pulse travels away from the 
transducer, it occupies a greater and greater volume.   This effect is called spherical spreading.  The 
general rule is that the intensity of the sound falls off as the square of the distance traveled.  In respect to 
typical acoustic measurements, this mathematically becomes a loss of 6 decibels for each doubling of the 
distance. 
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For echo sounders, the distance actually traveled is two times the distance to the seafloor from the source 
transducer (from the transmission source, to the bottom and back again).  This results in a significant 
source of signal loss for the system receiving the sound pulse, which must be compensated for at the 
receiver.  Typically a Time Varied Gain (TVG) amplifier is used to correct for spherical spreading loss in 
an acoustic receiver.  A TVG amplifier works by applying an increasing amount of gain to the return 
signal as time of travel increases. 

 
Attenuation Loss 

Attenuation of sound energy in the oceans comes from three factors: absorption, scattering (or 
reverberation) and bottom loss. Sound absorption takes place at two levels; one, absorption in the actual 
seawater medium, and two, absorption into the seafloor.  Primary causes of absorption are viscosity and 
thermal conductivity in the molecules of water as the sound travels.  At the molecular level, absorption is 
primarily related to frequency. At high frequencies- 500 kHz, for example, a loss of  0.14 dB/meter 
occurs in seawater, while at 50 kHz the loss is only 0.014 dB/meter.  This is a major concern when 
selecting a transducer required to meet specified depth criteria.  A graph showing the attenuation loss 
versus frequency is shown in Figure 1-1. 

 

Figure 1-1 Absorption Coefficient Versus Frequency 



STRATABOX  
Operations And Maintenance Manual 

INTRODUCTION - 1-4 
2002 Ocean Data Equipment Corp. 

 

Sound reflected off the seafloor usually suffers a significant loss in intensity.  Part of this loss is due to 
scattering (reflection) but most of it results from the portion of sound entering the new medium and 
traveling into the seafloor until it is completely absorbed.  The amount of energy lost by this effect varies 
greatly and depends on bottom type, sound frequency, and the angle at which the sound intersects the 
seafloor.  Total losses can vary from 10 dB to 40 dB, with hard bottoms (packed sand, rock outcrops) 
causing little loss, and soft bottoms causing a significant amount of energy loss (muddy, silt-like 
sediments).  Therefore, it is necessary when designing an echo sounder to compensate for this wide range 
in signal variation. 

Another form of attenuation is scattering, also called reverberation, which results when sound reflects off 
components in the water column.  Some of these reflectors include boundaries (sea surface and bottom), 
bubbles, biological material, suspended particulate and water type boundaries such as thermoclines.  As 
the sound pulse travels from the transducer, it will reflect off these objects in many different directions.  
The larger the area of the reflector compared to the wavelength of the transmitted sound, the more 
effective it is as a scatterer.  During the scattering process, part of the sound is reflected back to the 
surface, and the rest is scattered in all directions.  This will cause a reduction in the acoustic energy that 
can travel to the seafloor and back to the transducer.  For echosounding, this causes a reduced signal 
strength, which complicates location of the bottom.  In the extreme case, scatterers will cause such a good 
reflection it looks like the bottom to the echo sounder and corrections must be made by the user to 
properly determine the digitized bottom value. 

Bottom reverberation occurs whenever a sound pulse strikes the ocean bottom.  In deep water this 
condition normally does not cause serious problem, but in shallow water reverberation can happen 
multiple times, causing high background signal levels (i.e. the sound travels from the surface to the 
bottom and back again many times). 

Noise Sources 

Background noise can cause interference with the reception of the desired acoustic echo return from the 
seafloor.  Unlike reverberation, however, noise does not result from the transmitted pulse but from active 
producers of noise located at the ship or in the water.  Noise can be classified as self produced or ambient 
noise.  

Self-noise 

Self-noise is produced by noisy ship components, electrical circuitry, and water turbulence around the 
transducer, including noise caused by water flow and cavitation. 

Machinery noise and other sonar systems are the main components of ship produced self-noise.  The 
dominant source of machinery noise is the ship power plant, including the main engine, generators, and 
propellers.  The only way to reduce the effect of these noise makers is in proper selection of the 
transducer frequency for the echo sounder, and to locate the transducer as far away as possible from the 
noise sources.  Typically, these sources are of lower frequencies than the echo sounder, but some 
mechanical and electrical equipment will produce sound in the ultrasonic region (above 15 kHz) which 
can detrimentally affect the performance of a system. 

In general echosounding, flow noise, cavitation, and sonar circuitry are more important than other noise 
sources.  Flow noise results when there is a difference in the relative motion between  the transducer and 
water surrounding it.  As flow increases, friction between an object and water increases, resulting in 
increased turbulence and, thus, increasing noise due to varying static pressure in the water.  Flow noise is 
directly related to the speed of the ship and, on an improperly mounted transducer, there is usually a 
certain speed threshold that will cause the echo sounder to start picking up unwanted noise.  Increased 
flow noise over time can usually be attributed to growth of marine animals and plants on the bottom of 
the ship. 
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Cavitation is a result of the pressure on the face of the transducer reducing to a level that permits the 
water to boil (i.e. turn from a liquid to a gas).  This is directly related to the flow around the transducer as 
described above.  Cavitation is also related to the depth, source level, and frequency of the transducer 
being used.   As the depth of the transducer increases, static pressure increases to levels that will prevent 
cavitation from occurring.  If the transducer is mounted properly, with flow noise and cavitation levels 
considered, this phenomenon should never affect an echo sounder. 

Cavitation may also occur on a ship’s propeller.  As the speed of the water increases over the surface of 
the propeller, turbulence causes changes in the static pressure of the water.  At this point, if the pressure is 
low enough, boiling will occur.  This process releases a large quantity of bubbles into the water, causing 
noise that can affect the performance of an echo sounder.  Care should be taken to mount a transducer as 
far as possible from this noise source.  

Ambient Noise 

Ambient noise is always present in the ocean.  This noise is caused by both natural or human-made 
events.   For echosounding principles, ambient noise sources that are significant include hydrodynamic 
boundaries, ocean traffic and biological transmitters. 

Hydrodynamic noise results from natural phenomenon such as wind, waves, rain or currents.  The levels 
produced vary greatly, but are largely related to the sea state level.  In severe storms, hydrodynamic noise 
can reach levels that make reception of a transmitted signal very difficult, if not impossible. 

Ocean traffic noise is dependent on the number of ships, the distance from noise sources, and the current 
propagation conditions due to thermoclines and sea state.  Ocean traffic generally produces acoustic noise 
that is not within the frequency bandwidth of most navigational echo sounders, except when ships pass 
very near to the receiving transducer. 

Biological noise producers include marine life such as shrimp, fish, and mammals.  Mechanical 
movements of crustaceans, with their hard shells, may produce significant noise when in large schools.  
Likewise, certain fish species produce noise by reflecting noise off their swim bladder. 

Transducer Properties 

Properties of a chosen transducer affect sonar performance which directly relates to depth measurements.  
The source level, directivity index, and beam width of a transducer have a relationship with how the sonar 
system performs under different conditions. 

Source Level 

Sound is created by a transducer from a mechanical vibration of the ceramic material of which underwater 
transducers are made.  The movement of the transducer face creates alternating regions of high and low 
pressure, resulting in an acoustic wave.  The amount of energy transmitted into the water column is 
defined as the acoustic source level.  A source level is expressed in units of decibels that describe the 
intensity of sound relative to a reference intensity at one unit distance from the sound source.  For the 
user, a source level is useful for selecting a transducer for a particular use. 

The amount of movement on the face of the transducer is linearly related to the voltage difference created 
across the ceramics of the transducer.  Normally it would seem desirable to put as much power into the 
water as possible to achieve maximum depth performance.  Cavitation, however, which results from high 
source levels and small transducer depths below the sea surface, is generally the limiting factor when 
driving a transducer.  The electrical and mechanical design of the transducer, which has a maximum 
recommended input power level, must also be considered.  
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Beam Width 

The beam width of a transducer is described as the width of the main lobe of a transmit pattern.  The 
width is usually measured between the -3 dB points on either side of the beam pattern.  Shown in Figure 
1-2 is a transmit beam pattern for a 125 kHz transducer.  The shape of the transducer beam pattern is a 
result of the transducer design.  An array of ceramic elements, or a single ceramic element, emits sound at 
given frequency.  The spacing of the elements and the frequency being used can control the shape of the 
beam pattern.  At the center of the beam pattern is the main lobe of the transducer, with a width of 7 
degrees (centered at zero degrees).  The -3 dB point is shown as a dashed line on the graph.  The side 
lobes of this transducer are the smaller lobes, approximately 18 dB below the level of the main lobe. 

 

Figure 1-2  Acoustic Beam Pattern 

 

The width of a beam is important for calculating how small an object the system can detect.  If two 
objects fall within the main beam the object will appear as one object when it is received by the system.  
Thus, a narrow beam width is required for navigational echo sounders so it is capable of discriminating 
small objects. 

The size of the transducer sidelobes (smaller beams off to the side of the main lobe) is important in 
determining how the system will behave on steep slopes.  On steep slopes, transmitted acoustic energy 
from the side lobes will be received first and reveal a signal that looks like the actual bottom.  In reality, 
the bottom is directly below the ship, and as seen by the main lobe, is much deeper.  For this reason, it is 
important to select a transducer which has reduced sidelobes.  
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Directivity Index 

The directivity index measures the ability of a transducer to reject noise from extraneous sources.  In the 
ocean, noise may be coming from all directions, but a narrow beam transducer will only “hear” noise 
within the beam width pattern.   A sonar systems signal to noise ratio (SNR) will be affected by the ability 
of a transducer to reject unwanted noise, and thus is related to the directivity index.  The higher the 
directivity index of a transducer, the better the ability to reject unwanted noise. 

1.4 Specifications 

1.4.1 Stratabox Sensor Specifications 
 

Units Feet or Meters 

Depth Ranges 
0-15, 0-30, 0-60, 0-120, 0-240, 0-450 Feet 
0-5, 0-10, 0-20, 0-40, 0-80, 0-150 Meters 

Shift Range 
0-450 Feet in 1 Foot increments 
0-150 Meters in 1 Meter increments 

Zoom Range 
15, 30, 60, 120, 240 Feet 
5, 10, 20, 40, 80 Meters 

Zoom Modes Bottom Zoom, Bottom Lock Zoom, Marker Zoom, GUI Zoom (Playback Only) 

Display 
Normal Data, Zoom Data, Navigation, Depth, Command/Status, Color Control 
for Data: 4 Selections or Custom (User Input), Data Color Invert possible 

Strata Resolution 6 cm with 40 Meters of bottom penetration 
Depth Resolution 0.1 Feet, 0.1 Meters 
Depth Accuracy ± 0.5% 
Speed of Sound 1500 Meters/Second, 4800 Feet/Second 

Geographic Position 
NMEA 0183, GLL, GGA, RMC, VTG, VHW, HDT 
Selectable Baud Rates (RS-232):  4800, 9600, 19200, 38400 

Data Interface ODEC Stratabox Interface, 57600 Baud (RS-422) 
Printer Output Centronics (Parallel Port) interface to TDU Series Thermal Printers 
Shallow Water 

Operation 
< 2.5 Meters; bottom type dependant 

Transmit Rate Up to 10 Hz, depth and operator mode dependant 
Event Marks Periodic and/or Manual (Periodic selectable in 1 minute intervals) 

Data File Output 
Stores Depth, Navigation, and Graphic Data in ODC format (Proprietary) 
Normal and Zoom Data stored is Pixel data and can be played back and/or printed 

Data File Playback 
Files can be played back and/or printed at Normal or Fast-Forward speed, with 
Pause and GUI Zoom available 

Frequency Output 10 KHz 
Transmit Output 

Power 
300 Watts (Pulsed), 1000 Watts capable 

Input Power 10-30 Volts DC, Nominal power 8 Watts, Reverse Polarity and Over Voltage 
Protected 

Dimensions 25.4 cm (10”) Length, 15.876 cm (6.25”) Width, and 6.25 cm (2.5”) Height 
Weight 0.9 kg (2.0 lbs) 

Environmental 
-25°C to +60°C Operating Temperature (-55°C to +90°C Storage) 
Water Resistant to EN60529 IP65 
EMC meets EN60945 Emissions; CE Compliant 
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2.0 INSTALLATION 

2.1 - Stratabox System Installation Overview 

This section presents instructions for initial setup and installation of the Stratabox Sensor. Physical and 
electrical installation details are provided for connecting, mounting, and getting started with the 
Stratabox. A summary is given of the software installation and setup procedure as well.  

Although the Stratabox Sensor is designed to deliver the highest levels of quality and performance, it can 
best attain those standards when the equipment has been properly installed. Because of the great variety 
of vessels that will employ the Stratabox Sensor, it is not feasible to provide complete and detailed 
instructions that will fit all installation possibilities. Therefore, this section will provide practical 
guidelines to assist the user in planning a typical installation of the Stratabox System aboard the vessel.  

Shown in Figure 2-1 is a system-interconnecting diagram. Optional items are shown with dashed lines. A 
minimum operational system configuration requires:  

 
1. PC running Windows 98 (Windows 95/2000/ME will work as well, Pentium II @ 266MHz or 

greater) 
2. Stratabox Sensor Unit 
3. Stratabox Transducer Assembly 
4. Stratabox Cables (Power, Data, Transducer) 
5. 10-30 Volt DC Power Source (8 Watts) 
6. Transducer Mounting Hardware 
 

The GPS System is optional but, if used, will require the PC to have an additional COM port.  For many 
portable PC’s a 2nd COM port may be installed via one of the PCMCIA expansion slots. 

The TDU Printer, if used, is attached via the PC’s Printer Port. 
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Figure 2-1 System Interconnect Diagram 

2.1.1 -  Getting Started 
 
Unpacking and Inspection 

Use care when unpacking the unit from it’s shipping carton to prevent damage to the contents. It is also 
recommended that the carton and the interior packing material be saved even after the unit has been 
installed on the vessel. In the unlikely event that it is necessary to return the unit to the factory, the 
original carton and packing material should be used. Verify that all parts described in the next section 
have been shipped with the unit. 

Basic Equipment  

The following (Table 2-1) is a list of the basic equipment supplied with the Stratabox Geophysical 
Instrument (P04400): 

Part 
Number 

Item Quantity 

P04403 Stratabox Sensor Unit 1 
P04462 Stratabox Transducer Assembly 1 
P04412 Power Cable (10 feet) 1 
P04413 Data Cable (10 feet) 1 
P04415 Transducer Cable (30 feet) 1 
P04421 Stratabox Software CD 1 
P04425 Stratabox Manual 1 

Table 2-1 Basic Equipment 
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Accessories and Options  

The following items are available to complement and enhance the operation of the Stratabox Profiler. 
Please contact your authorized ODEC distributor or visit our web site for information and assistance in 
obtaining any of these items. 

 
Product 
Code 

Item Quantity 

P02553 TDU-850 Thermal Printer 1 
P03100 TDU-1200 Thermal Printer 1 
P03120 TDU-2000F Thermal Printer 1 
P03050 12 Channel DGPS System w/ Combo Antenna 1 
P04465 Over-the-Side Mounting Kit 1 

Table 2-2 Accessories and Options 

 

2.1.2 - Installing the Stratabox Electronics  
 

Instructions are provided in this section regarding the physical installation of the Stratabox Sensor Unit 
and the PC that is used for the User Interface. Guidelines are provided for locating and/or mounting the 
Stratabox Sensor unit and the PC. The installer should refer to Section 2.1.4 for information on electrical 
hookup.  

Selecting a Location for the Electronics  

The Stratabox Sensor Unit is designed for portable, marine applications but maybe used in permanent 
installations as well.  The user must determine if the Stratabox Sensor Unit is to be mounted on the vessel 
or just placed in a convenient place on-board the vessel.  Either way the appropriate location for the unit 
needs to be determined.  The following considerations should be investigated before deciding upon a 
location: 

1. User Supplied Personal Computer 

The first step in the equipment location process is to determine the optimum place for viewing the data.  
The unit should be positioned to provide the optimum viewing angle and within easy reach of the operator 
whenever possible. This will vary depending on the size of the vessel and type of  Personal Computer 
(Desktop or Laptop) but is most important to insure the comfort and success of the user.  The location 
selection should consider that standard PC displays are not easily readable in direct sunlight.  Adequate 
space for the computer and any peripherals that need to be connected should be considered as well.  
Finally, provisions need to be made to properly secure the equipment for the worst sea conditions that 
may be encountered. 

2.  Cable Lengths. 

Both the Data Interface Cable and the DC Power Cable supplied with the product are 10 feet long.  Thus, 
the Sensor Unit must be installed within 10 feet of both the user supplied Personal Computer and a 10-
30VDC Power Source. The unit must also provide adequate access for cabling termination without 
binding, and allow suitable space for servicing the equipment.  (If necessary, the data cable may be 
extended beyond 10 feet.  See Section 2.1.4 for more information) 
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3.  Water Resistance. 

The Sensor Unit has passed the EN60529 IP65 Water Resistance Standard which insures that the unit is 
completely sealed and is Splash Proof.  The unit should NOT however be installed in an area where the 
unit may be submerged in water. 

4.  Environmental. 

The operating temperature of the Stratabox Sensor is –25C to +60C thus the operating temperature range 
of the PC is likely the limiting factor for temperature.  The unit has also passed all of the EN60945 
emission tests (radiation and immunity).  For optimum system performance it is still recommended that 
the installer mount or place the Sensor unit in an area that is at least several feet away from any other 
electronic equipment or machinery on the vessel.  The unit should also be mounted or placed in an area 
that won’t be exposed to water if practical. 

Mounting the Sensor Unit 

 This section outlines the steps for mounting the Sensor Unit.  Refer to Figure 2-2 while installing.  The 
unit may be mounted either horizontally or vertically.  The keyhole slots make installation in hard to 
reach areas easier, but be sure to tighten all mounting hardware securely.  Insure that adequate room is left 
for installing and removing the cable connections.  Also, verify that the status indicator (labeled STAT) is 
visible.   

 
Step 1)  Confirm that the area behind the intended-mounting surface on the bulkhead is clear of 

equipment, panels, electrical cables, conduits, hydraulic, air, water lines or pipes.  
 
Step 2) Using the Sensor Unit as a template mark a drill point for each of the mounting holes.  Insure that 

the marks for the keyholes are placed in the smaller, slotted areas.  
 
Step 3) Drill four (4) holes that will work with the mounting hardware that has been selected (not 

supplied).  The 4 holes on the Electronic unit are .195 inches in size (#8 size Screw recommended 
for installation).  
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Figure 2-2 Bulkhead Mounting the Sensor Unit 

 

2.1.3 - Installing the Stratabox Transducer  
 
General Transducer  

The Stratabox is equipped with a single lightweight, Line-in-Cone transducer that is designed for 
portable, over-the-side mount applications.  It may also be used in permanent installations but will need to 
be mounted in a water filled seachest in those installations.  Before installing the transducer, the installer 
should read and understand the appropriate section below to insure that all of the installation issues are 
considered. 

Selecting a Location for the Transducer 

The location of the transducer is very important for maintaining reliable bottom tracking and optimum 
subbottom performance of the equipment.  Avoid installing transducers in locations where the transducer 
will be subjected to turbulent water, air bubbles, or vibration.  The best clear water location on most 
vessels meeting these criteria is approximately 1/3 the length of the vessel, aft from the bow.   

For many portable applications and some permanent applications it is not practical to mount the 
transducer in the forward section of the vessel.  For these applications the transducer can be located in the 
aft third of the vessel; away from and forward of shafts and propellers, clear of hull openings, sea chests, 
outlets or protuberances.  It is preferable to mount the transducer on the side of the hull where the 
propeller blades are normally moving downwards.  The upward motion of the propeller can generate 
pressure waves, which push air bubbles up against the hull.  By mounting the transducer on the downward 
side, the hull will tend to protect the transducer from this effect. 
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The transducer should be mounted adjacent to the ship’s centerline.  The radiating face should be flush 
with the hull and, wherever practical, the face should be parallel to the waterline.  A maximum deadrise 
angle of 3 degrees is allowable. 

The transducer must be mounted such that it will always remain submerged during operation.  Thus, the 
depth of the transducer should take into account the location on the vessel and the worst case sea state 
conditions.  Turbulent flow across the radiating face of the transducer and/or the presence of air bubbles 
will degrade system performance significantly as well and must be considered. 

The area selected for mounting must provide sufficient space for access to the transducer and cable, and 
for routing cable and conduit.  In addition, there should be sufficient room to permit use of the necessary 
tools to facilitate the installation-mounting requirements.  Ideally, the location would provide a relatively 
direct cable run to the site of the Stratabox Sensor Unit. 

The cable path from the Electronics to the transducer should be routed as far as possible from other 
electrical cables.  Although the cable is shielded, the acoustic reply from the transducer can be on the 
order of microvolts, thus any cable crosstalk emissions can cause a decrease in acoustic sensitivity.  

Handling Transducers 

The transducer is the heart of the Stratabox system and, in spite of its appearance and size, is a delicate 
instrument.  Although it is designed to be in contact with and survive tough marine environments, it 
should not be dropped or mishandled during the installation.  Caution is advised when handling the 
transducer to prevent any damage to the transducer face or radiating surface. 

The Line-in-Cone transducer is comprised of a large ceramic, cylindrical ring element affixed to a plastic 
cone with baffling.  The Transducer Mounting Ring is provided to make it easy to secure the Stratabox 
Transducer to a mounting surface.  This assembly also provides protection for the Transducer and should 
be affixed to the transducer at all times. The transducer and mounting assembly should be as clean and 
smooth as possible so the path of the sounding energy is uninterrupted.  The transducer face must not be 
painted with lead based bottom paint.  In portable applications the transducer and mounting assembly 
should be cleaned with fresh water after use. 

 
WARNING: Do not expose the transducer to any solvents when cleaning any excess 

sealants.  Strong solvents may damage the face of the transducer. 
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MOUNTING HOLES
Ø0.404 (10.26mm) THRU, 6 PLACES 

EQ. SPACED ON A Ø15.13 
(384.3mm)B.C. ASSEMBLY

MOUNTING RING

5.75"
(146mm)

Ø16.38 (416mm) Dia.

SPIDER MOUNT

Ø0.50 (12.7mm) Dia. (2 PLcs.)

Ø5.5" (139.7mm) Dia.

 

 Figure 2-3 Transducer Mounting Ring 

Also, when handling the transducer, avoid lifting or pulling on the transducer cable.  Although the cable 
appears thick and substantial, the internal cable wiring could be damaged by stress from the sheer weight 
of the transducer and cause a malfunction at the most inopportune time. 

Portable Transducer Installation 

Portable installations of the Stratabox transducer for most survey vessels will be of the over-the-side pipe 
mount type.  This type of installation is achieved with the following list of materials: 

 
Part Number Item Quantity 
P02590 Stratabox Transducer 1 
P04462 Stratabox Transducer Mounting Assembly 1 
User Supplied Silicone grease or petroleum jelly (Vaseline®) 1 
User Supplied Pipe coupling 1 

User Supplied 
Pipe with threads to match the pipe coupling and length to give 
proper transducer depth 

1 

User Supplied Pipe coupling adapter 1 
User Supplied Support Lines or cables 2 
User Supplied Pipe Clamps to affix the Pipe to the 4x4 1 (or 2) 
User Supplied Pressure Treated 4x4x (Ship’s Beam Width + 2 feet) 1 
User Supplied Large “C” Clamps to affix the 4x4 across the beam of the vessel 2 
User Supplied Protective Pads or Carpet Remnants 2 
User Supplied Mild Household Detergent (i.e.,dishwashing liquid) 1 

 Table 2-3 Portable Transducer Installation Parts 
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Refer to Figure 2-4 below while reading and implementing the Installation procedure listed below. 

 

 Figure 2-4 Over The Side Transducer Mounting 

 
CAUTION:  Never pull, carry or hold the transducer by the cable as this may sever 

internal connections. 
 
Installation Procedure: 
 
1.   Apply silicone grease or petroleum jelly to the threads of the pipe to facilitate later disassembly. 
2.   Twist the pipe coupling onto the pipe. 
3.   Push the transducer cable through the pipe. Alternately after the transducer is attached, clamp the 

cable to the outside of the pipe using cable clamps. 
4.   Apply silicone grease or petroleum jelly to the transducer stem.  Insure that the grease does not smear 

the face of the transducer. 
5.   Attach 2 lines or cables to the Transducer Mounting Assembly.  These lines or cables will support the 

pipe from the force of the water when the boat is underway. 
6.   Attach the Pipe Clamp(s) near the end of the 4x4 insuring that there is enough clearance for the 

transducer to hang over the side of the vessel. 
7.   Place the 4x4 across the beam of the vessel near the stern and fasten it to the gunnels with the C 

Clamps.  Use the Protective Pads or Carpet Remnants to protect the gunnels of the vessel.  Insure that 
the 2 foot extra length of the 4x4 extends beyond the beam of the vessel on the appropriate side and 
that the Pipe Clamp(s) attached to the 4x4 are on the extra length as well. 

8.   Attach the Transducer/Pipe Assembly to the 4x4 using the Pipe Clamps.  Insure that the transducer is 
deep enough into the water that sea conditions will not cause the transducer to get to the surface. 

9.   Fasten the line(s) or cable(s) fore and aft with sufficient tension to support the pipe when the boat is 
underway. 
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10. Route the cable to the instrument being careful not to tear the cable jacket.  To reduce electrical 

interference, separate the transducer cable from other electrical wiring.  Coil any excess cable and 
secure it in a place with zip-ties to prevent damage. 

 
Portable Transducer Maintenance 

Aquatic growth can accumulate rapidly on the transducer's surface reducing its performance in weeks. 
Clean the surface, keeping it free of marine growth and petroleum residue, with a soft cloth and mild 
household detergent. Inspect the cable periodically for kinks, abrasions and cuts. Repair any damage 
using an approved waterproofing cable repair system. Inspect connections for indications of corrosion. 

 
 WARNING: NEVER USE SOLVENTS!   
             Certain cleaners, gasoline, paint, sealants and other products may contain strong 

solvents, such as acetone, which can attack many plastics dramatically reducing 
their strength. Clean surface of transducer with a mild detergent only. 

 
Permanent Transducer Installation  

For some applications it may be necessary and/or convenient to mount the Stratabox Transducer 
permanently in the hull of the vessel.  Due to the construction of the Stratabox Transducer it may NOT be 
directly affixed to the hull of the vessel.  A Seachest Installation is required.  Guidelines for performing a 
Seachest installation are described in the following sections. 

 
Seachest Transducer Installation 

Interior Seachest installations are best suited for solid fiberglass hulls to permit a minimum attenuation of 
acoustic reply signals.  Hulls of other type material types may be considered but most other hull types will 
require that a Seachest design be built into the hull with an acoustic window across the face of the 
enclosure (i.e. a significant hole must be cut out of the hull). 

Inside mounting to the hull does minimize drag to allow faster survey speeds, however, significant loss of 
subbottom performance may result due to the attenuation loss in the hull.   

Locate the transducer where the hull is solid fiberglass resin to maximize sound transmission. Do not 
locate over balsa wood core material. Consult the hull manufacturer if you are unsure of the core material 
or the be st location. Never bond large resin housings directly to the hull; always use a liquid-filled box. 

In any permanent installation the intended final configuration should be tested before it is implemented, if 
possible. 
 
For more information regarding the installation of a Seachest or other permanent transducer mount, refer 
to our website at http://www.oceandata.com/support/install/xducer.htm, or contact us directly. 

http://www.oceandata.com/support/install/xducer.htm
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2.1.4 - Electrical Connections 
 
WARNING: Be sure to turn the vessel power off at the main switchboard before 

proceeding with the installation.  If power is left on or turned on during the 
installation, then fire, electrical shock or other serious injury may occur. 

There are 3 connections that need to be made to the Stratabox Sensor Unit and the PC for the system 
function properly.  The user also has the option of connecting a GPS input and/or a Thermal Printer.  The 
sections below describe the connection details for each. 

All electrical connections to the Stratabox Sensor unit are to the side of the unit.  Refer to the sections on 
each individual connector for information on connector type, recommended cable and wiring specifics.  
Figure 2-1 at the beginning of the chapter shows the overall systems interconnect for the system.  

 
 

 Figure 2-5 Stratabox Sensor Unit Connections 

Figure 2-5 shows the basic connections to the unit.  In all installations, all of the connections must be 
made for the unit to function.  As shown above, there is a status indicator (STAT) and there are 3 
connectors from left to right: DC Power (3 pins), Data Interface (8 Pins), and the Transducer (10 Pins). A 
grounding screw, located to the right of the Transducer connector, is provided to connect the Stratabox to 
the vessel’s earth ground system.   The cables supplied with the Stratabox are ready to plug into the 
Stratabox Sensor Unit.  No user wiring is necessary.  The cables associated with the Stratabox Sensor 
Unit are listed below (Table 2-4).  The user should make sure that, after wiring is complete, each plug is 
firmly attached to the unit via the twist-lock mechanism. 

 
Part Number Item Quantity 
P04412 DC Power Cable (10 feet) 1 
P04413 Data Interface Cable (10 feet) 1 
P04415 Transducer Cable (30 feet) 1 

 

 Table 2-4 Stratabox System Cables 
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DC Power Connection 

Before installing the power connection to the unit, the installer must first insure that the DC power source 
is in the range of 10-30VDC and is capable of providing 8 watts of power to the unit.  Although the 
Stratabox Sensor unit is reverse polarity and over-voltage protected, it is always required that the power 
mains be turned off during system wiring for both personal and equipment safety. 

The Power Cable supplied with the system is 10 feet long, and includes 3 conductors.  The wires in the 
power cable must be connected as follows: 
 
RED  – Positive DC Voltage (Fused Lead), DC IN+ 
BLACK  – DC Return, DC IN- 
WHITE  – Earth Ground, SHLD 

The Positive DC Voltage lead includes a 3 Amp in-line Fuse.  In the unlikely event that the fuse is blown 
it should be replaced with a fuse of the same amperage.  Installing an incorrect fuse can result in damage 
or fire to the unit if it is not operating properly. 

The Power Connector on the Sensor Unit is shown below in Figure 2-6. 
 

 

 Figure 2-6 Stratabox Sensor Power Connector 

 

Electrical wiring standards require that the Stratabox Sensor Unit be properly attached to a solid chassis 
ground via the ground stud on the bottom of the unit, or the Earth Ground wire (WHITE) in the power 
cable.  When connecting to the ground stud, a tinned copper braided wire (0.190 gauge or greater) is 
recommended. 

 
NOTE: Connecting the Earth Ground is required for optimum system performance and 

safe operation.  The white wire in the power cable OR (BUT NOT BOTH) a ground 
wire to the unit ground stud is needed.  Connecting both the white wire and the 
ground stud to earth ground may degrade performance due to induced ground 
loops. 
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Data Interface Connection 

The Data Interface cable supplied with the Stratabox is 10 feet long.  It includes 8 conductors and an RS-
422 to RS-232 conversion block.  This block connects directly to the COM port of the PC and derives its 
input power from the DTR and/or RTS signal lines from the PC.  For nearly all applications, the Data 
Interface can be connected as supplied.   

If the 10 foot length of cable is not enough, the Data Interface Cable may be extended by using a 
standard, 1 to 1, 9 pin D to 9 pin D extension cable.  This cable must be connected between the RS-422 
side of the conversion block and the 9 pin D connector attached to the Data Interface cable.  The 
extension cable must be shielded to guard against interference.  The Data Interface Connector on the 
Sensor Unit is shown below in Figure 2-7 

 

 Figure 2-7 Stratabox Sensor Data Connector 

Transducer Connection 

The Stratabox transducer wiring is comprised of 2 cable sections. 

The first cable section is 6 feet long and is directly connected to the ceramic inside the transducer.  There 
is a waterproof inline connector at the end of this cable section suitable for connection in a flooded 
seachest or in seawater.   

The second cable section is 30 feet in length and has the waterproof mate to the first cable section on one 
end and a 10 pin connector on the other end that mates to the Transducer connector on the Stratabox 
Sensor Unit.  Only 3 of the pins on the 10 pin connector are wired to the unit.  They are defined as: 

 
WHITE  - Transducer + 
BLACK  - Transducer – 
GREEN  - Transducer Shield 
 
The Transducer Connector on the Sensor Unit is shown below in Figure 2-8. 
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 Figure 2-8 Stratabox Sensor Transducer Connector 

GPS Connection 

Connecting a GPS or other Navigation input to the PC running the Stratabox software allows the user to 
store and annotate Date, Time, Position, and Heading information to the Acoustic data returns. 

The Stratabox PC Software supports the NMEA 0183 protocol on a 2nd COM port that is software 
selectable by the user.  When selecting a PC to use with the Stratabox system the user should insure that 
PC hardware supports 2 COM Ports if a Navigation input is desired (the Stratabox Sensor/PC interface 
requires 1 COM port). For Portable PC’s, a PCMCIA COM port card can often be used to provide a 2nd 
COM port. 

The user should refer to the GPS NMEA 0183 output connection information in their GPS Manual as well 
as the PC COM port wiring information in their PC Manual to insure that the Navigation input is wired 
correctly. 

Printer Connection 

The Stratabox PC Software allows the user to interface to the all of the ODEC TDU Thermal Printers.   
The connection is established through the PC’s Parallel Printer Port (25-pin D-Type) as shown below in 
Figure 2-9.  Once the software has been started, all displayed acoustic data can be printed to the TDU in 
either Acquisition or Playback mode. 

 
 

 

Figure 2-9  Printer Port 

 
The standard TDU Printer cable is provided with the printer and is 12 feet long and does not require any 
user wiring.  Installers must locate the printer accordingly. 
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2.2 - Stratabox PC Software Installation 

This section describes how to install the Stratabox PC software package.  It is assumed that the reader has 
a working knowledge of installing Windows 95/98/2000/NT software.  The installation software is 
located on the CD-ROM disc included with your Stratabox. 

 
NOTE: It is recommended that you exit all running applications before inserting the CD 

and beginning the installation. 

To install the PC software, insert the Stratabox CD into an available drive.  If Auto Insert Notification is 
enabled on the CD-ROM drive, then the Stratabox PC installer will begin automatically.  If the CD does 
not auto-start, simply execute the SETUP.EXE file in the root directory of the CD. 

Once the installer is running, it will verify that your operating system is compatible with the Stratabox 
software, and then it will check which version of the Windows Installer program is installed in your 
system.  If the Windows Installer program is not found or out of date, it will update it and prompt you to 
restart your computer.  Once restarted, the Stratabox installation will continue automatically. 

The InstallShield Wizard will guide you through the next step where you have the option of choosing an 
install directory.  By default, the Stratabox PC software is installed in the Program Files folder under the 
sub-directory ODEC. 

In the next step, you may choose a Typical, Minimal, or Custom installation.  Selecting Typical will 
perform a complete install of both the Stratabox application and Sample Data for playback.  A Minimal 
installation will only install the Stratabox application.  Additionally, you can choose Custom to manually 
select what you would like installed.  Click the next button to continue to the next step. 

The rest of the installation process consists of verifying your settings and clicking the install button.  
Also, once the installation is complete, you can check the Launch the program box to execute the 
Stratabox software as soon as you close the installer.  If not, you can run the Stratabox PC software by 
using the Windows Start button to find the Stratabox menu under Programs, or simply double-click on 
the Stratabox icon located on your Desktop. 

 



STRATABOX  
Operations and Maintenance Manual 

OPERATION - 3-1 
2002 Ocean Data Equipment Corp. 

3.0 OPERATION 

3.1 Stratabox PC Software 

This section describes how to operate the Stratabox Sensor using the PC Software package included with 
your Stratabox. 

3.1.1 - The Main Window 

The Stratabox Main interface is divided into two fields, the Controls and Status field, and the Data 
field.  The vertical window boundary between the fields may be positioned by the user as desired. 

The Controls and Status field is located in the left portion of the window.  It provides access to all of the 
user controlled parameters.  Specifically, the Controls and Status field includes digital depth, an 
animated compass with heading marks in degrees, GPS Position, Time/Date, Ping Count, available disk 
space (for data storage), and Stratabox Sensor status. 

The Data field is located in the right portion of the window.  It displays the actual echo data The Data 
field can be viewed in either Normal or Zoom mode.  In Normal Mode, the entire Data field is used for 
displaying non-zoomed bottom data.  In Zoom Mode, the Data field is divided in half to show zoomed 
data on the left and normal bottom data on the right.  See the below picture and table for more info.  (The 
picture reflects the software in Zoom mode) 

 

 
NOTE: The current on-screen bottom image in both Zoom and Data windows will be lost 

upon resizing the window 
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1. The Toolbar 
 
Quick access to common Stratabox functions.  From left to right they include: 
 

 Open A Playback File 

 Insert Text Annotation 

 Insert Manual Event Mark 

 Toggle Playback Zoom 

 Toggle TDU Printer On or Off 

 Get Stratabox Software And Version Info 

 Starts the Stratabox Sensor Pinging 

 Stops the Stratabox Sensor Pinging 

 Playback a Previously Recorded File 

 Toggle Fast Forward/Normal Playback 

 Pause Playback 

 Stop Playback 
 
NOTE: Playback buttons are available in Playback mode only and will be disabled 

otherwise. 
 

2. Navigation/Depth Display 

These indicators provide navigation and digital depth info to the user in real-time.  Navigation/Depth  
information includes the digital depth, current Date/Time, global position, and ping count.   

The digital depth is shown to 1 decimal place in both Feet and Meters and is displayed in a large font to 
make viewing easier from a distance.  The depth value is updated once per ping and will show -.- if the 
depth is not found or invalid. 

The Date/Time shown is based on the user’s PC clock by default and can be displayed in Local time or 
GMT (See User Preferences in Section 3.1.2.1).  If the PC is connected to a GPS receiver that is receiving 
valid navigation data, the Date and Time on the user’s PC can be synchronized to the UTC Date/Time 
transmitted from the GPS (See “Configure Nav Inputs” in Section 3.1.2.1 for more information).   

Position info is also provided when a GPS receiver is connected to the PC and the Stratabox Software is 
configured and receiving valid GPS data.  When GPS Position data is not available, the display will show 
“Latitude N/A” and “Longitude N/A”.  If the Stratabox PC Software is receiving position data, it will be 
provided in Decimal Minutes format. (i.e. 41° 22.74402’ N, 71° 36.25902’ W) 
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The ping count is included to provide the user with a means of estimating how fast the Stratabox Sensor is 
pinging, and also for how long.  The ping count is reset to zero when any of the following events occur:  
 
- The Stratabox PC Software is restarted. 
- A Recording or Playback file has begun. 
- The Stratabox Sensor has temporarily lost power and reset. 
 
In addition, the Stratabox software features an animated compass which displays the current heading.  
The compass is located underneath the GPS position information. 
 
3. Gain and Auto Controls 

The Gain controls consist of 2 pull-down menus which control the Stratabox Sensor’s gain settings.  The 
Stratabox Hardware gain is controlled by the DC Gain control and can be set either from 0-75 dB, or to 
Auto Mode.  The BT Gain controls the Bottom Triggered gain which allows the user to amplify acoustic 
returns in the sub-bottom sediments.  The BT Gain is first applied at the bottom depth value and 
increases over time at the selected dB/unit increment. It can be set from 0.1 - 2.0 dB/unit (Either Feet or 
Meters, depending on which is currently enabled) in 0.1 increments.  For example, consider the 
following: 

Bottom Depth is 40.0 meters 
Range is set to 0 - 80 meters 
BT Gain is set to 0.5 dB/m 
DC Gain is set to 30 dB 

From 0 – 40 meters, the total gain will remain 30 dB as set by the DC Gain control.  After 40 meters, 
however, the total gain will increase by 0.5 dB every meter, giving you 35 dB of total gain at 50 meters, 
40 dB at 60 meters, etc.  The BT Gain can only apply up to 30 dB of additional gain. 

Depressing the Auto All button sets the Stratabox Sensor to automatically choose the best Range (Refer 
to next section for more information on Range) and hardware Gain settings, making bottom tracking 
easier for the user.  Clicking the Auto All button again will toggle the Stratabox back to manual mode. 

The BT Gain is not auto-controlled in Auto All mode.  This allows the user to select the BT Gain best 
suited to the bottom features present for their application. 

 
NOTE: When in Auto All mode, the DC Gain control is not available and will be controlled 

by the Stratabox automatically.  While the control is disabled, it will indicate which  
hardware gain setting that the Sensor has chosen. 

 
4. Range, Zoom Range, and Shift Controls 

The Range control allows you to choose a manual range for the Stratabox Sensor.  It includes 6 range 
settings presented in either Feet or Meters. 

The Zoom Range control has 5 settings which are used to set the range of the Zoom window.  These 
values will be in either Feet or Meters depending on which units are currently selected.   
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The Shift Range control allows you to choose a manual offset to the start depth on the graphic display.  
The user enters an integer value, in either Feet or Meters depending on which is currently selected, to set 
the top of the water column.  The water column viewed will reflect the shift depth at the upper limit of the 
display and will extend the entire range amount.   

For example, if a range of 0 – 80 meters is selected, and a Shift value of 10 is selected, the water column 
range will become 10 – 90 meters.  The Shift value cannot exceed 450 feet, or 150 meters.  It will also 
NOT be available nor have any effect while in Auto All mode. 

 
NOTE: When in Auto All mode, the Range control is not available and will be controlled 

by the Stratabox automatically.  While the Range control is disabled, it will indicate 
the current Range setting that the Sensor has chosen.  Shift Range will also not be 
available nor have any effect in Auto All mode. 

 
5. Sensor State 
 
This indicator shows the current state of the Stratabox Sensor.  There are a total of 6 different states: 
 

Unknown  - No communication is present between the Sensor and PC Software. 
Power On - Power has been applied to the Stratabox and the Sensor has begun  

  communicating. 
Initializing - The Stratabox software is handshaking with the Sensor to establish a reliable 

  connection. 
Idle - A connection between the PC and the Stratabox Sensor has been established,  

  but no commands have been received yet. 
Pinging  - The Stratabox Sensor is transmitting and receiving real-time bottom data. 
Playback  - The PC Software is displaying previously recorded data from a playback file. 
Post Failure - The Stratabox Sensor did not pass the initial Power On Self Test.  This error 
     will always include an error code. 

 
6. Color Palette and Unit Controls 

The Stratabox PC Software allows you to choose from 4 standard color palettes by clicking on one of the 
radio buttons located in the Color Control section.  If you wish to create your own palette, you can do so 
by selecting Custom and clicking on the button to right of it.  You can also reverse the current palette by 
using the Invert box. 

Along side the Color Control is the Units control.  You can choose to display depth and range information 
in Feet or Meters.  You can also check the Milliseconds box to display range and zoom range scale bars in 
Milliseconds rather than Feet or Meters. 

7. File Capture Status 

This unique feature allows the user to view the Recording status when capturing data to a hard disk.  The 
status shows the drive letter of the destination drive as well as a graph depicting how much free/used 
space is present on that drive.  During recording, the current filesize will be shown also. 
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8. Range Markers 

These scalebars show the full range of the data windows and are based in the current unit selected.  Also, 
if GUI Zoom is activated, two slider bars will be visible on the right scalebar.  They are used to specify 
the GUI zoom window boundaries.  In addition, when Marker Zoom is enabled, a single slider bar will 
appear and is used to specify where the water column will begin in the marker zoom window. 

3.1.2 – The Menu Bar 

The Stratabox PC Software has 4 menus on the menubar including File, Edit, View, and Help.  Most of 
the Stratabox Software Preferences and Navigation configuration are accomplished through these menus. 

3.1.2.1 – The File Menu 

 
 

Start Recording 

Creates a new file on the specified hard disk for capturing acquisition data.  If the Stratabox Sensor is 
already pinging, then the software will start the data recording immediately.  The filename is based on the 
date/time in the following format: 

 
<path>YYYYMMDDhhmmss.odc 
 
<path> - This represents the path to a directory where the recorded files should be stored.  Refer 
   to User Preferences in this section for information on manually setting the path. 
YYYY - 4-digit Year 
MM - 2-digit Month 
DD - 2-digits Days 
hh - 2-digits for Hours 
mm - 2-digits for Minutes 
ss - 2-digits for Seconds 
.odc - ODEC’s Proprietary File Extension 
 
 

NOTE:  Once recording is started, this option will become “Stop Recording”. 
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Open for Playback 

Opens a previously recorded file for reviewing.  All other Playback functions are controlled by the 
coinciding buttons in the toolbar.  Playback filenames are created based on the date/time.  (Refer to the 
above section for more information) 

Configure Sonar Port 

 
 This menu allows you to choose which PC COM port the Stratabox Sensor is connected 
to.  In addition, you can enable/disable communication to the sensor by toggling the “Enable 
Serial IO” check box. 

 
Configure Nav Inputs 

 

 This menu allows you to configure your system to receive NMEA 0183 navigational information 
from a GPS receiver, or equivalent.  Using the “Enable Serial IO” checkbox, you can enable/disable this 
option.  If enabled, you can choose the appropriate PC COM port and communication parameters.  Most 
GPS units are setup to use 8 Data bits, No Parity, 1 Stop bit, and either 4800 or 9600 Baud.  In addition, 
you can choose which NMEA format the software uses to collect navigational data.  Make sure you 
choose a format compatible with your GPS receiver.  Check your GPS manual for more information. 

The “Synchronize System Time to GPS Time” option is provided as a means to synchronize the internal 
PC clock to the UTC Date/Time from the GPS.  The RMC Sentence is the only one which included GPS 
Date and Time and so this option is only available when the RMC Sentence is selected for “NMEA 
Position”.  It will be disabled otherwise.    
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Configure Events 

 

This menu is used to configure eventing and annotation.  Events may be generated by using the toolbar 
button, or the corresponding menu option “Insert Event Mark” under the Edit menu.  An event is a 
vertical marker which appears on both the screen and printer.  A number of real-time parameters may be 
included with the events as derived by the user.  These parameters are shown in the above picture under 
“Annotate Event Mark With...”.  In addition, the user can choose to only insert event marks when one is 
requested (Manual Eventing Only), or have the Stratabox software do it periodically.  While in periodic 
mode, the user can still insert manual event marks in addition to the periodic ones.  All event marks are 
inserted between the acquired bottom data so there is no loss of information. 

Configure Thermal Printer 

 

This menu allows you to configure a thermal printer for use with the the Stratabox software.  It supports 3 
different models from the Raytheon/ODEC TDU series, including the TDU-850, TDU-1200, and the 
TDU-2000.   
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In addition to Enabling or Disabling the printer, there are a number of other options available to the user.  
These settings only affect the thermal printout, not the on-screen display.  They include: 

• Display Negative Image 
- Enabling this option will invert the gray scale colors on the thermal printout. 

 
• Flip Rasters Left to Right or Top to Bottom 

- Enabling this option will print a mirror image of the event/annotation marks.  This 
option is to be used in conjunction with the L/R dip switch located on the back of the 
TDU Printer (Refer to your TDU Manual for more information).  By default, the switch 
is set to the L position and so this option should not be enabled.  However, if the dip 
switch is set to R, enable this option to print the event/annotation marks correctly. 

 
• Print Grid Lines and Range Markers 

- Enabling this option will print the data along with 4 grid lines and periodic range 
markers. 

 
• Print Annotation Text Transparently 

- By default, this option is not enabled and annotation is printed with a solid background 
so that the text is always readable. This will cause some bottom data not to be shown 
on the printout, but will still be present on the display and recording file (if recording is 
on). Enabling this option will print annotation text without a solid background.  This 
may make annotation text hard to read when printed over bottom data.   

 
• Repeat Raster Count 

- A Repeat Raster Count can be entered between 1 and 10.  The default count is 1 Raster.  
Increasing this value will cause the printout to be stretched horizontally.  This option is 
useful when using a TDU-1200 or TDU-2000 printer which has a finer vertical 
resolution. (i.e. Pixels are small)  
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User Preferences 

 

 This menu allows you to configure recording and playback options.  By selecting “Playback files 
continuously”, the current playback file will repeat from the beginning when it reaches the end.  The 
Stratabox software stores recorded data files in the same directory as the application by default, however, 
you can select an alternate location by clicking the “Browse” button and specifying another directory.  
Additionally, you can limit the maximum recorded file size by enabling the “Automatic File Size” option.  
If the recording file reaches the specified size, it will create additional files to save the remaining data.  
This option is useful if your data will be transferred to removable media where space is limited. 

 The “Time Display” control allows the user to specify which Time Zone the Date/Time should be 
based on.  The Date/Time shown on the display will also be the value recorded to a file if recording is 
active.  Choosing “Local Time” will enable whichever Time Zone is currently selected in the Windows 
operating system.  (Refer to your Windows User Guide for more information regarding Time Zones).  
Selecting “UTC Time” will display Date/Time information based on the GMT Time Zone. 

 In addition, both the Local Time and UTC Time zones can be synchronized to GPS Time 
provided that a GPS Receiver is connected to the Stratabox PC Software and configured correctly.  (Refer 
to Configure Nav Inputs in Section 3.1.2.1 for more information) 

 
Recent Files 
 
 The Stratabox software keeps a list of the 4 most recently opened playback filenames for easy 

access.  These filenames are found between the “User Preferences” and “Exit” menu options.  
Clicking one will immediately begin playback of the file. 

 
Exit 
 

You can exit the Stratabox PC Software by either using the “Exit” on this file menu, or by simply 
clicking on the windows default close button. 
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3.1.2.2 – The Edit Menu 
 

 
Insert Event Mark 

Selecting this option will generate and insert a formatted event mark on the display, in the 
recorded file (if recording is on), and if enabled, the thermal printout.  The event mark contents 
can be configured by selecting “Configure Events…” under the File menu.  In addition, an event 
mark can also be inserted by clicking the corresponding toolbar button. (See Section 3.1.1) 
 

Insert Annotation 
 Selecting this option will allow you to enter a custom text message to be inserted on the display, 

the recorded file (if recording is on), and if enabled, the thermal printout.  In addition, annotation 
text can also be inserted by clicking the corresponding toolbar button.  (See Section 3.1.1) 

3.1.2.3 – The View Menu 

 
Toolbar 

 Selecting this will toggle the toolbar on and off.  (Refer to Section 3.1.1 for more information on 
toolbar). 

 
Status Bar 
 Selecting this will toggle the Status Bar on and off.  The Status bar is located at the bottom of the 

Stratabox application and displays extended information about a particular button or function. 
 
Raster View / Wiggle Trace 

 The Stratabox software allows the user to display bottom information in two formats, Raster view 
or Wiggle Trace.  In Raster view, bottom information is depicted graphically with bottom intensity being 
represented by the different colors in a specified color palette.  In Wiggle Trace view, the bottom 
information is shown ping by ping with acoustic energy being represented horizontally.  
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NOTE: Wiggle Trace mode is only available in the Normal display.  All zoom data will 

appear in Raster mode. 
 

Enable GUI Zoom 

 This option allows the user to digitally scale bottom data from a playback file and can function as 
a manual zoom.  This feature was included in order to provide a method to zoom in on bottom data 
previously recorded without one of the Stratabox Sensor’s enhanced zoom modes enabled.  When 
enabled, two zoom bars will appear on the scalebar of the Normal Data window.  These bars can be 
dragged up or down in order to set the GUI zoom range.  Data displayed in GUI Zoom is derived from 
recorded Normal data. 

 
Display Modes 

The Stratabox Sensor features an enhanced multi-mode zoom.  It provides a smooth, magnified high-
resolution window of the bottom.  The enhanced zoom modes are acquired in real-time and are 
displayed/recorded at higher sample rates than the Normal data (assuming the zoom range is smaller than 
the normal range).  

There are 4 display modes available with Stratabox software, including 3 Zoom modes, and 1 without any 
zoom.  They include: 

 
Normal 

This mode displays the normal bottom data by itself without any zoom information.  When selected, this 
mode will use the entire viewing area. 

 
Bottom Zoom 

When selected, this mode will split the viewing area in half.  The left side will be used to show zoom 
information, and the right side for normal bottom data.  Bottom Zoom mode centers the zoom display 
around the current depth allowing you to follow it up and down the water column at a high resolution.  In 
addition, the user can use the Zoom Range Control to zoom in or out.  The Zoom Range value represents 
the zoom range in whichever units are currently selected.  When the zoom window moves up or down to 
track the bottom, it does so in Zoom Range / 2 increments. 

 
Bottom Lock Zoom 

This mode functions the same way as Bottom Zoom, however it does not show the bottom moving 
through the water column.  Instead, it will lock the bottom to the upper portion of the zoom view so that 
the user may continuously monitor sub-bottom information.  

 
Marker Zoom 

 Like in the other modes, Marker Zoom provides a high-resolution zoomed view of the water 
column, however in this mode, the user can specify where in the water column the zoom range will begin.  
This is accomplished by dragging the marker zoom bar up or down the normal view scalebar to the point 
you want the zoom range to begin.  The start of the zoom range can be observed at the top of the zoom 
window while you drag the marker zoom bar, but the marker zoom isn’t set until the mouse button is 
released. 
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3.1.2.4 – The Help Menu 

 This menu includes a software Help guide along with an About Stratabox option.  Clicking it 
will display a window with information such as the Stratabox software version and ODEC company 
information.  In addition, the software will request and display Hardware/Firmware version information 
from the Stratabox Sensor providing the Sensor is connected and communicating properly. 
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4.0 MAINTENANCE 

4.1 – POST (Power On Self Test) 
 

Each time power is applied to the Stratabox Sensor, it performs a series of self-tests to ensure that it is 
working optimally.   The tests occur as follows: 

 
Test 1 – Initialization Test 

   Checks overall functionality of the sensor hardware to verify it is operational. 
 
 Test 2 – RAM Test 
   Verifies that the system RAM is operational. 
 
 Test 3 – Serial EPROM Test 

Verifies that the Serial EPROM is operational and it’s checksum is valid. 
 
 Test 4 – Flash Memory Test 

Verifies that the Flash Memory is working and it’s checksum is valid. 
 

If Test 1, 2, or 3 fail, the Sensor’s green LED will blink rapidly at 4 Hz indicating an error.  The Stratabox 
Sensor will not be operational and the user should contact ODEC’s Support Dept. for assistance.  If the 
Sensor fails Test 4, the green LED will blink normally at 1 Hz, but will not function until it is 
reprogrammed.  The Stratabox PC Software will detect this problem and notify the user.  (Refer to 
Troubleshooting Section 4.4)  

If the Sensor passes these tests, the green LED will blink at 1 Hz indicating that it’s working and waiting 
for communication with the PC and Stratabox PC Software. 

4.2 – LED Indicator 

The Stratabox Sensor is equipped with a green LED which was designed to give the user immediate 
information regarding the Sensor’s status.  When power is supplied to the Sensor and it is working 
properly, the LED will blink at 1 Hz indicating that the unit has powered up correctly and is waiting for 
communication with the PC and Stratabox software.  Once communication is established, the LED will 
stay on continuously.  However, if the unit is powered up and the green LED blinks at 4 Hz, then the unit 
is problematic and will not be able to communicate with the PC until the problem is rectified.  (See 
Troubleshooting Section 4.4) 

4.3 – Firmware Update 

The Stratabox Sensor is a self-contained unit and has it’s own set of Firmware.  Periodically, ODEC may 
offer Sensor Firmware upgrades which add new features and functionality.  This section describes the 
process involved in updating that firmware. 
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4.3.1 – Connection 
 

The Stratabox Sensor Firmware does not need any special connection cables or connectors to perform an 
update.  The Sensor is connected to an available COM port (Usually COM 1) on a Portable PC as if it 
were being used to acquire data.  (See Data Interface Connector in Section 2.1.4).   

4.3.2 – Firmware Update File 

If a Firmware Update file is available, ODEC can send the user a disk containing the file, or it may be 
downloaded from our website (http://www.oceandata.com).  The file will always be called 
StrataFW.hex.  This file should NOT be renamed because the Stratabox PC Software is configured 
to only detect it’s specific filename.  

This file should always be COPIED from the disk to the PC rather than being moved.  This allows the 
user to retain a copy of the file on disk for backup purposes.  Before copying the file, the Stratabox PC 
Software should NOT be running.  The file should be copied to the same directory as the Stratabox 
executable file.  (Usually C:\Program Files\ODEC\Stratabox x.xx, unless otherwise 
specified). 

4.3.3 – Stratabox PC Software Firmware Update 

The Stratabox PC Software is designed to automatically detect the presence of a firmware update file 
upon startup.  If the file is detected, the user will be notified and asked whether the firmware update 
should take place.  If the user chooses “No”, then the Stratabox PC Software continues to run normally. 

 
NOTE: If the user chooses “No”, the firmware file will REMAIN in the Stratabox 

directory.  The file must be manually removed to avoid being detected each time 
the software is run. 

 

Before the user chooses “Yes”, the Stratabox Sensor must be reset back to the Power-up state.  This can 
be done by removing power from the Sensor (Either at the connector, or power supply) and then 
reapplying it.  The green LED on the Sensor should be blinking at 1 Hz indicating that it’s in the Power-
up state.  For more information regarding the LED indicator, see Section 4.2. 

When the user clicks “Yes”, then the PC Software will attempt to communicate with the Stratabox Sensor 
while giving the user status message updates.  If there are no problems, the firmware upload will begin 
and a progress indicator will be shown to the user.  Refer to Section 4.4 for troubleshooting information. 

NOTE: If the firmware update is successful, the firmware file WILL be removed from the 
Stratabox directory to prevent it from being detected again.  Make sure you have a 
backup copy of this file.  
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4.4 – Troubleshooting 
 

4.4.1 – Stratabox Sensor Troubleshooting 
 

Symptom Possible Cause Solution 
Green LED on Sensor does not 
turn on Sensor is not receiving power 

Check the power supply, inline 
fuse, and connections to the 
Sensor with a voltmeter 

Green LED on Sensor blinks 
rapidly at 4 Hz 

Power on Self Test 1, 2 or 3 has 
failed 

Contact ODEC Support Dept for 
assistance 

Green LED on Sensor blinks at 1 
Hz but cannot establish 
communication with PC software 

1) Connection problem between 
PC and Sensor 

2) PC Software not setup to use 
correct COM port  

3) Flash Memory is corrupt 

1) Check connections between 
PC and Sensor 

2) Select the correct COM port 
in the “Sonar Port” menu 

3) Contact ODEC Support Dept 
for assistance 

 

4.4.2 – Stratabox PC Software Troubleshooting 
 

Symptom Possible Cause Solution 

Sensor State always shows 
Unknown 

PC Software not receiving 
communication from Sensor 

1) Check connections between 
PC and Sensor 

2) Make sure the Sensor’s LED 
is blinking at 1 Hz indicating 
that is ready for 
communicating 

3) Verify the software is setup 
to use the correct COM port 
for communicating with 
Sensor 

Sensor State stuck in Power-up 
PC Software was executed after 
Sensor has already been 
initialized 

Cycle (remove then reapply) 
power to the Stratabox Sensor 

PC Software not receiving GPS 
information 

1) PC Software is not setup 
correctly 

2) There is a connection 
problem between the PC and 
GPS Receiver 

1) Correctly configure PC 
Software in the “Nav Inputs” 
menu to the correct COM 
port and to a compatible 
NMEA string with your GPS 
Receiver 

2) Check connections between 
PC and GPS Receiver 

PC Software is non-responsive or 
lagged 

Thermal Printing is enabled but 
no TDU is connected 

Check connection between PC 
and TDU or disable Thermal 
Printing in software 

 
END OF MANUAL 



STRATABOX  
Operations And Maintenance Manual 

MAINTENANCE - 4-4 
2002 Ocean Data Equipment Corp. 

 
 

THIS PAGE INTENTIONALLY LEFT BLANK 


	TABLE OF CONTENTS
	TABLE OF FIGURES
	TABLE OF TABLES
	INTRODUCTION
	General Information
	About This Manual
	Echo Sounding Principles
	Underwater Acoustics
	Decibels
	Sound Propagation


	Figure 1˚1 Absorption Coefficient Versus Frequency
	Figure 1˚2  Acoustic Beam Pattern
	Specifications

	INSTALLATION
	- Stratabox System Installation Overview
	Figure 2˚1 System Interconnect Diagram

	-  Getting Started
	Table 2˚1 Basic Equipment
	Table 2˚2 Accessories and Options

	- Installing the Stratabox Electronics
	Figure 2˚2 Bulkhead Mounting the Sensor Unit
	- Installing the Stratabox Transducer
	Figure 2˚3 Transducer Mounting Ring
	Table 2˚3 Portable Transducer Installation Parts
	Figure 2˚4 Over The Side Transducer Mounting

	- Electrical Connections
	Figure 2˚5 Stratabox Sensor Unit Connections
	Table 2˚4 Stratabox System Cables
	Figure 2˚6 Stratabox Sensor Power Connector
	Figure 2˚7 Stratabox Sensor Data Connector
	Figure 2˚8 Stratabox Sensor Transducer Connector
	Figure 2˚9  Printer Port
	- Stratabox PC Software Installation

	OPERATION
	Stratabox PC Software
	- The Main Window
	– The Menu Bar
	– The File Menu
	– The Edit Menu
	– The View Menu
	– The Help Menu



	MAINTENANCE
	– POST (Power On Self Test)
	– LED Indicator
	– Firmware Update
	– Connection
	– Firmware Update File
	– Stratabox PC Software Firmware Update
	– Troubleshooting
	– Stratabox Sensor Troubleshooting
	– Stratabox PC Software Troubleshooting



		2002-02-01T01:30:52-0500
	Providence
	Douglas Flowers
	Document is released




